Ectaco, Inc. assumes no responsibility for any damage or loss resulting from the use of this manual.

Ectaco, Inc. assumes no responsibility for any loss or claims by third parties which may arise through the use of this product.

Ectaco, Inc. assumes no responsibility for any damage or loss caused by deletion of data as a result of malfunction, repairs, or battery replacement. Be sure to back up all important data on other media to protect against its loss.

The contents of this manual are subject to change without notice.

No part of this manual shall be reproduced, stored in a retrieval system, or transmitted by any means, electronic, mechanical, photocopying, recording, or otherwise, without permission from Ectaco, Inc.
## CONTENTS

### INTRODUCTION

### GETTING STARTED
- General View
- Power Supply
- MultiMedia Card
- Control Pad
- Main Menu
- Control Wheel
- Opening and Closing Programs
- On-screen Keyboard

### SETUP
- Interface Language
- Select Date
- Select Time
- Volume
- Password
- Sounds
- Pen Language
- Shutoff Time
- Time Format, Date Format, Numbers
- Week Start
- Double-click

### APPLICATIONS
- Phrasebook
- Self-Learning Mode (Flash Cards)
- Address Book
- Calculator
- Date Book

---

1 where available
Memo Book ------------------------------------------ 18
Music Player ---------------------------------------- 18
ToDo Book ------------------------------------------ 19
Voice Memo ------------------------------------------ 19
Currency Conversion ------------------------------- 20
Local Time ------------------------------------------ 20
Metric Conversion ---------------------------------- 20
World Time ------------------------------------------ 20

PC COMMUNICATION---------------------------------- 21
INTRODUCTION

Congratulations on purchasing ECTACO Partner® B-3! You are now the owner of the versatile, handheld electronic device which will serve you as a comprehensive phrasebook, personal organizer, and a music player.

ECTACO Partner® B-3 features:

- Total of 14,000 travel oriented phrases
- Human pronunciation of phrases in the phrasebook
- Self-Learning Mode (Flash Cards)
- Music Player (additional MMC required)
- Address Book
- Calculator
- Date Book with audio reminders
- Memo Book
- ToDo Book
- Voice Memo
- Currency and metric converters
- Local and World time with map illustration
- Bilingual interface²
- High-speed data exchange and synchronization with PC
- Password protection
- Search function
- High resolution touch screen
- MMC slot
- USB port
- Headphone jack

This model features a breakthrough combination of two input methods — a well-designed on-screen keyboard and a high-resolution touch-sensitive handwriting area which makes character input simple, fast and accurate.

² where available
♦ **Note:** As continuous efforts are made by the manufacturer to ensure better quality and performance of the product, some characteristics or the design of the actual device you purchased may slightly differ from those described in this manual.
GETTING STARTED

General View
The general view and external appliances of ECTACO Partner® B-3 are shown below:

- Press the On/Off button to turn the device on. When the device is on, press and hold the On/Off button for approximately two seconds to turn on the backlight. Press and hold the On/Off button once again to turn the backlight off.
- Use the connecting cable provided in the standard package to connect ECTACO Partner® B-3 to the LS-101 loudspeaker.
- Tap the screen with the supplied pointing device called the stylus which, when not in use, is conveniently kept in a special slot at the side of the device’s back panel.
- In most windows or dialog boxes, tap OK or Done to accept changes or Cancel to exit without saving any changes.

♦ Note: If, for some reason, using the stylus does not provide the desired effect, you may need to recalibrate the screen (see Launcher Menu on page 11).

Power Supply
ECTACO Partner® B-3 is powered by two AAA (LR03) batteries. ECTACO Partner® LS-101 loudspeaker is powered by four AAA (LR03) batteries. If the battery power runs too low, the unit will start up when you press the On/Off button but will then shut off automatically. When this happens, please replace the batteries immediately to avoid the risk of losing user data.
♦ **Note:** Make sure the battery is inserted in the battery compartment before connecting your device to a PC.

**How to replace the batteries**

- Press the *On/Off* button to turn the device off.
- Make sure the device is not on a hard surface – if the *On/Off* button is pressed accidentally, user data may be lost.

♦ **Note:** To avoid data loss, **never try to remove the batteries from the device when the power is on.** If you experience difficulties turning the device off, press the *RESET* button on the back of the device and restart the system.

- Remove the battery compartment cover.
- Remove the used batteries and replace them with new ones.

♦ **Note:** Do not mix old and new batteries.
- Make sure to place the batteries according to the polarity marks (+ -) inside the battery compartment.
- Put back the battery compartment cover. Make sure the cover sits in place properly.

♦ **Note:** You have one minute to replace the batteries without risk of losing the data stored in RAM. **Do not exceed the one-minute limit!** Neither the manufacturer nor the dealer may be held responsible for the loss of user data.

**MultiMedia Card**

ECTACO Partner® B-3 MultiMedia Card is included in the standard package. Please insert the card into the MMC slot before you turn the device on.

♦ **Note:** Always **make sure the device is turned off** before installing or removing the MMC. Use the *On/Off* button to turn the device off.

**Installing MMC**

- Put your thumb on the MMC slot cover and slide it off.

- Slide the MMC into the compartment with the contacts face up and the label face down. Push the card gently until it clicks into place.
- Snap the cover back on and then turn on the device.
The operating system installation will take about 2 minutes.

- To perform screen calibration, tap the center of the target with the stylus. Repeat the process with three more targets, which will appear one after another.

**Removing MMC**

- To remove the MMC, first turn the device off. Push the card in slightly. You will hear a click and the card will pop out.

**Soft Reset**

- Tap \( \overset{\frown}{\text{H}} \) to go to the Main Menu and then tap \( \overset{\frown}{\text{H}} \) to open the Launcher Menu.
- Tap *Restart system* on the Launcher Menu.
- In the *Ready for Restart* screen, tap *Restart now*.

If the Launcher Menu is not accessible, use the *RESET* button.

**Hard Reset**

After a hard reset all user data will be lost.

- To perform the hard reset, keep the *On/Off* button pressed while pressing the *RESET* button.

**Control Pad**

**Control Pad Elements and Their Functions**

- **Launcher icon**: Switch to the Main Menu.
- **Menu icon**: Show the available menus. Menus shortcuts, where available, are shown to the right of the menu items.
- **Handwriting area**: Write letters in the *Letter input area* "abc", punctuation in the *Punctuation input area* ":-)", and numbers in the *Number input area* "123".
- **Scroll area**: Scroll the screen content.
Main Menu

ECTACO Partner® B-3 Main Menu contains a row of three tabs at the bottom of the screen and the universal indicator. The tabs are named as follows: Phrasebook, Organizer, and Extras.

- Use the Phrasebook tab to access Phrasebook and Self-Learning Mode (Flash Cards).
- Use the Organizer tab to access the following applications: Address Book, Calculator, Date Book, Memo Book, Music Player, ToDo Book, and Voice Memo.
- Use the Extras tab to access the following applications: Setup, Currency Conversion, Local Time, Metric Conversion, and World Time.

Universal indicator is a graphic item located in the lower right corner of the Main Menu. By default, it shows the current time.

- Tap the universal indicator a few times to successively display the current date, percent of remaining battery power, battery power graphic, and the amount of available memory in the device.

Launcher Menu

- When in the Main Menu, tap  to invoke the Launcher Menu.

Handwriting Guide

- When in the Main Menu, tap  and then select Handwriting Guide.
- Tap the arrows  to scroll through each screen of the Handwriting Guide.

Note: Before you input accented characters (where available), please make sure you have selected the appropriate Pen Language (see page 13).

Control Wheel

- Turn or push the control wheel to select, open, or hear an entry pronounced, where available.
- Turn the control wheel to scroll one page when reading a text.
Note: The control wheel turns up and down; it does not spin. Please do not put excessive force on the control wheel.

Turn the control wheel to control the volume when listening to music.

**Opening and Closing Programs**

- To open a program, tap its corresponding icon.
- To return to the Main Menu without closing the program, tap . To immediately return to the program, tap once again.
- To exit a program, tap in the top right corner, or use the File / Exit command.

**On-screen Keyboard**

- To invoke the on-screen keyboard, draw a line straight up outside the Handwriting area or tap , where available.

### SETUP

- Tap the Setup icon from the Extras tab to launch the application.

**Interface Language**

- Tap ▼ next to Interface and then select the desired language. The device will reboot and then all the messages and menus will appear in the chosen language.

**Select Date**

- Tap anywhere on the date field to change the date or view another date.

**Select Time**

- Tap the up and down arrows to change the hour and minute.
- When 12-hour format is set, tap AM or PM to toggle between AM and PM.

**Volume**

- To increase or decrease the volume, move the slider to the right or left.

---

^3 where available
Password

Setting the Password
• Tap * * * * to open the Enter password screen.
• Specify a password up to 8 characters in length. Tap OK.
• Retype the password for confirmation. Tap OK.

Changing or Clearing the Password
• Tap * * * * to open the Enter password screen.
• Input the current password. Tap OK.
• Specify a new one. When clearing the password, leave the filed blank. Tap OK.
• Retype the new password for confirmation. Tap OK.
♦ Note: Always remember your password. If you forget it, you will have to reset the system, which may cause irrevocable loss of user data.

Disabling or Enabling the Password
• Go to the Main Menu, tap ☢ and then select Disable Password.
• To re-enable the password, tap ☢ and then select Enable Password. This option will require password entry when the device is turned on.

Sounds
• Select the Quiet Mode check box to turn the device sounds off.
♦ Note: Music files, and the Date Book alarm are not affected by this option.

Pen Language
Allows you to activate character recognition for several languages, where available.

Shutoff Time
Allows you to set the time that elapses before the device automatically turns off.

Time Format, Date Format, Numbers
• To set the format for the time, date, or numbers, tap ▼ and then select the desired format.

Week Start
• Tap ▼ and then select Monday or Sunday.

Double-click
Allows you to set the speed at which the screen recognizes taps from the stylus.
APPLICATIONS

Touch buttons

<table>
<thead>
<tr>
<th>Button(s)</th>
<th>Function(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎤</td>
<td>Pronounce translation (in Phrasebook)</td>
</tr>
<tr>
<td>🔄</td>
<td>Change the operating mode (in Phrasebook)</td>
</tr>
<tr>
<td>🎤</td>
<td>Change the direction of translation</td>
</tr>
<tr>
<td>📀</td>
<td>Phrasebook setup</td>
</tr>
<tr>
<td>📀</td>
<td>Add the highlighted entry to a set of flash cards</td>
</tr>
<tr>
<td>📀</td>
<td>Invoke the on-screen keyboard</td>
</tr>
<tr>
<td>📀</td>
<td>Change the font size (three font sizes available)</td>
</tr>
<tr>
<td>📀</td>
<td>Go to the previous or next entry respectively</td>
</tr>
<tr>
<td>📀</td>
<td>Open a new record template</td>
</tr>
<tr>
<td>📀</td>
<td>Delete a record</td>
</tr>
<tr>
<td>📀</td>
<td>Create a new set (in Self-Learning Mode)</td>
</tr>
<tr>
<td>📀</td>
<td>Rename the selected set (in Self-Learning Mode)</td>
</tr>
<tr>
<td>📀</td>
<td>Reset statistics for the currently viewed set (in Self-Learning Mode)</td>
</tr>
<tr>
<td>📀</td>
<td>Open the Edit set or Set setup screen (in Self-Learning Mode)</td>
</tr>
<tr>
<td>📀</td>
<td>Display the List of sets (in Self-Learning Mode)</td>
</tr>
<tr>
<td>📀</td>
<td>Create a set of 50 randomly chosen entries (in Self-Learning Mode)</td>
</tr>
</tbody>
</table>

Phrasebook

ECTACO Partner® B-3 substitutes for an interpreter in standard situations, such as registering at a hotel, shopping, visiting bank etc. You simply choose the appropriate phrase and the loudspeaker will pronounce its translation.

- Open the Phrasebook application. You will see the topics list. Please navigate to the desired subtopics and phrases lists as described below.
- Use the control wheel or stylus to highlight the desired topic.
- To open the selected topic or subtopic, just tap it once again or push the control wheel.
- To hear the translation pronounced, tap 🎤 or push the control wheel.
- To go up one level, just close the current window by tapping ✗.
Phrases Mode, Useful Words Mode, Search Mode

- Tap and then select Phrases mode (default setting), Useful words mode, or Search mode.

In the Phrases mode the application shows full sentences, some of which have changeable parts. These are shown in bold and underlined. For example, when viewing the phrase How frequent are the flights? you can tap the flights and change it to the trains. The phrase translation will change accordingly.

Switching to the Useful words mode is available in most topics. In this mode, the application shows words and speech patterns pertaining to the topic.

Use the Search mode to find the desired phrase by a keyword. You may input a whole phrase (for example, Thank you) or a single word (thank).

- In the search screen, enter the desired word and then tap on the Search button.
- When the desired phrase has appeared in search results, tap Stop and then tap on your phrase. The search screen will close and the program will show you the phrase with its translation in the respective topic.

Note: To reduce the search time, please open the desired topic before you start searching. Also, set the Start from option in the search screen to Current view. Clear the Case sensitive and Whole words check boxes to broaden your search.

Phrasebook Setup

- Tap to open the Phrasebook setup screen.
- Select the appropriate gender options under Speaking and Addressed to.
- Select the desired Font size.

Adding Entries to Flash Cards

- To add an entry to a set of flash cards, tap , then select the desired set and tap Add.

Note: The Phrasebook and Self-Learning Mode (Flash Cards) applications use the same database. When both applications are running simultaneously, the Object is in use message may appear at certain operations. This is normal, just close either of the applications by tapping .

Self-Learning Mode (Flash Cards)

ECTACO Partner® B-3 will help you enlarge your vocabulary quickly and advance considerably in learning a foreign language.

- In the beginning, please select the desired language by tapping and then tap .

You will see the Set setup screen.
• Tap to create a new set.

By default, the first set is named my set 1. Once you have created your set(s), tap to close the Set setup screen and return the Edit set screen.

• Choose the desired set by tapping ▼ in the upper part of the screen, next to Current set.

• To fill the current set with the Phrasebook entries, select the desired entry and then tap.

• Use to create a set of 50 randomly chosen entries.

When you have filled the desired set, you are ready to start learning.

• Tap to close the Edit set screen. The Flash Cards screen will be shown.

• Use the available touch buttons (see page 14).

The number of unlearned cards in a set is recorded for each game. This information is displayed on the screen. For example, Left: 10 means you have 10 cards unlearned.

• Tap the Drop button to set a card apart.

• To go to the next card, tap Next >>.

• Select the Always show translation option to have the program show you translation in each card.

• Alternatively, tap on the Show Translation message to see the translation. To hide the translation, just tap on it.

• Tap to display the List of sets. Here you can select a new set for the game.

♦ Note: You cannot select an empty set.

Your goal is to learn all cards in your set. You may quit the game and resume playing at any time. Just launch the application to start playing beginning from where you left.

**Address Book**

Your ECTACO Partner® B-3 includes Address Book, a standard organizer program for storing names, telephone numbers, street and electronic addresses.

### Creating a Record

• Tap New.

• Tap in the data entry column next to the desired label.

• To see additional labels, tap the button for the desired view and then tap in the data entry column next to the desired label. Tap ▼ to see the drop-down list and select the name you want. Enter your information in every view and field you want.

• In the Personal view, tap Details to select the phone number you want displayed.
**Editing Entries**
- 1) Tap the desired entry and then tap in the data field you want to change.
- Enter or edit information in any view and field.
- Tap *Done* or ✗ to save your changes and return to the Contacts List.
- 2) Or, hold your stylus down on the entry.
- Select *Edit* on the appeared menu.

**Custom Fields**
- From the Contacts List, tap ☑️ and then select *File / Custom Fields*.
- Tap in the field of the label you want to edit and specify the desired label name.
- Use *File / Preferences* to set the desired sort order.

**Searching for an Entry**
- When in the Contacts List, tap on the line next to *Search* and enter the first letter or letters of the entry you want to find.

**Deleting Entries**
- In the Contacts List, hold your stylus down on the entry you want to delete.
- Tap *Delete* on the appeared pop-up menu.

**Menus**
The *File* menu is available in the Contacts List and the *Edit* menu is available in each of the four views when the cursor is blinking.
- When the program is running, tap ☑️ to display the available menus.

**Calculator**
ECTACO Partner® B-3 includes a standard calculator with 10-digit display capacity.
- Use this program as a standard pocket calculator.

**Date Book**
A standard organizer program for scheduling.

**Adding Appointments**
- Tap *Go To*, select the desired month and day and then tap *Select*.
- **Note**: You must be in the *Daily View* to add appointments to your schedule.
- Tap on the desired line in the data entry column and enter your appointment.
- Tap the time approximate slot for your appointment to set a start and end time.
- In the *Edit* window, tap ☑️ to display the *Recurrence* screen.
- Tap the check box next to *Daily, Monthly, Weekly, or Yearly*.
- Tap a button (S M T W T F S) to set the day of the week for the recurring event.
• In the Edit window, use 🕒 to set the time when the alarm will sound.

Views
The Daily View displays the schedule for the selected day. It is the first screen you see when you enter Date Book. To return to this view from another screen, tap 📅. 
• Use 📚 to return to the current date.

The Weekly View displays the schedule for a single week. Tap 🔗 to go to the Weekly View.
• Tap ⬇️ at the bottom of the screen to see the week’s schedule as a list.
• Tap ⬆️ at the bottom of the screen to see the week’s schedule as a grid.
• The Monthly View displays the schedule for any single month. Just tap 📅.

Menus
There are two menus in Date Book: File and Edit. The File menu is available in the Weekly and Monthly Views and both menus are available in the Daily View.
• When the program is running, tap 📅 to display the available menus.

Memo Book
The Memo Book application provides you with a storage place for your notes.
• To add a memo, tap New and enter your memo. Tap Done to save it.
• Tap ▼ to see the Sort drop-down list.
• To view the whole memo, tap the number of the desired memo.

Editing Memos
• Tap the memo you want to edit.
• Place the cursor where you want to edit and then add or delete text. Tap Done.

Menus
There are two menus in Memo Book: File and Edit. The File menu is available in the memo list and both menus are available in the Edit screen.
• When the program is running, tap 📅 to display the available menus.

Music Player
ECTACO Partner® B-3 includes Music Player, a program allowing you to play music. The program supports MP3 files.
• To download MP3 files into your device, please use ECTACO Desktop Manager and a re-writable MMC (64 MB or above).
♦ Note: If the source MP3 file is in a wrong encoding, Music Player may not be able to recognize it or even may stop responding. Use the Active Programs menu to stop the program in this case.

Buttons

- Play, — Pause playing, — Stop playing, — Fast forward, — Rewind.

Menus

- When the program is running, tap □ to display the available menus.

ToDo Book

ToDo Book is a standard organizer program for managing your tasks.

Adding Entries

- Tap New and enter a todo text.
- Tap the Priority icon and select Low ( ), Normal ( ), or High ( ).
- Tap Edit to add settings.
- Tap on the completion check box to mark/unmark a todo as completed.

Editing Entries

- Place the cursor in a todo where you want to edit and make your changes.
- To delete a todo, hold the stylus down on the task. On the appeared menu, tap Delete.

Menus

There are two menus in ToDo Book: File and Edit. The File menu is available when no todo is selected in the ToDo List. When a todo is selected, both menus are available.

- When the program is running, tap □ to display the available menus.

Voice Memo

Voice Memo allows you to record memos and play them back.

Buttons

- Record a memo. This button changes to Stop when you are recording or listening. — Stop the memo recording or playing. — Play the memo. — Pause playing. — Fast forward. — Rewind.

Menus

- When the program is running, tap □ to display the available menus.
**Currency Conversion**

Allows you to instantly calculate cross rates for combinations of over 20 currencies.

**Setting and Checking Rates**

- Tap on the currency name to open the *Currency setup* window.
- Change/specify the *Currency name* and/or *Currency rate*. Tap *Save*.
- To add user-defined currencies to the list, tap ![官兵]. The *Currency setup* window will open. Enter the desired data into the *Currency name* and *Currency rate* fields.

**Conversion**

- Set the cursor position to the desired field in the right column of the table.
- Enter the value. The conversion is performed while you are typing.

**Local Time**

The *Local Time* application shows: the name of the city and country representing the local time zone and a map of the corresponding continent, the current date, and the current time.

- Tap ![官兵] to the left of the city or country name to open the list of cities or counties respectively.
- To add a new city to the list, tap ![官兵] to open the *New city* template.
- Use ![官兵] to hear the announcement of the displayed time.
- Use ![官兵] to turn *Daylight Saving Time* (DST) on or off.

**Metric Conversion**

With ECTACO Partner® B-3 you may easily convert units of measure.

- Choose a subsection by tapping ▼ in the upper left corner of the screen.
- Set focus to the desired field by tapping in it and then enter the value. The conversion is performed while you are typing.

**World Time**

Using ECTACO Partner® B-3, you may view current times in cities around the globe, along with appropriate map illustrations.

- Tap ![官兵] to the left of the city or country name to open the list of cities or counties respectively.
- To add a new city to the list, tap ![官兵] to open the *New city* template.
- Use ![官兵] to hear the announcement of the displayed time.
• Use 🕒 to turn Daylight Saving Time (DST) on or off.

**PC COMMUNICATION**

Using the USB cable and ECTACO Desktop Manager software you may exchange data between your ECTACO Partner® B-3 and a personal computer. This will allow you to keep a backup copy of user data. When prompted to specify a path to the device driver, go to the folder into which you have installed ECTACO Desktop Manager, then open the *USB_Driver* folder and select `ebookman.sys`. The default path is C:\Program Files\Ectaco\Desktop Manager\USB_Driver.

**Toolbar**

The ECTACO Desktop Manager toolbar buttons perform the following functions:

- 🔄 – synchronize data between your PC and ECTACO Partner® B-3.
- 📚 – go to the upper folder.
- 📚 – display files in the *Contents* folder.
- 📚 – display files from the *Library* folder in the *Contents* pane.
- 🔄 – switch from the *Connection* view to the *Contents* view.
- 🔄 – switch from the *Contents* view to the *Connection* view.

**Views**

In the *Connection* view, if ECTACO Desktop Manager detects the device, the image on the screen will show the connection. The *Contents* view uses two list panes to organize and display files stored on your PC (the *Contents* pane) and content stored in the device (the *Device* pane).

• Right-click on a file or folder to access its context menu.

**Menus**

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Synchronize</strong></td>
<td>Synchronize all files between the current <em>Contents</em> directory and the device.</td>
</tr>
<tr>
<td><strong>Send to device</strong></td>
<td>Move a highlighted file from the <em>Contents</em> pane to the <em>Device</em> pane.</td>
</tr>
<tr>
<td><strong>Send to PC</strong></td>
<td>Move a highlighted file from the <em>Device</em> pane to the <em>Contents</em> pane.</td>
</tr>
<tr>
<td><strong>Copy to Library Folder</strong></td>
<td>Copy a highlighted file to the <em>Library</em> folder.</td>
</tr>
<tr>
<td><strong>Copy to Contents Folder</strong></td>
<td>Copy a highlighted file to the <em>Contents</em> folder.</td>
</tr>
<tr>
<td>View Item</td>
<td>Function</td>
</tr>
<tr>
<td>--------------------</td>
<td>--------------------------------------------------------</td>
</tr>
<tr>
<td>Device Info</td>
<td>Display information about the device.</td>
</tr>
<tr>
<td>Toolbar</td>
<td>Display or hide the toolbar. By default, the toolbar is displayed.</td>
</tr>
<tr>
<td>Switch Panes</td>
<td>Switch the Contents and Device panes.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Reload the active pane.</td>
</tr>
</tbody>
</table>

**Note:** Due to a difference in the file systems of ECTACO Partner® B-3 and PC, file sizes shown in the Contents pane may slightly differ from those shown in the Device pane.